
1. PRINCIPIO DI FUNZIONAMENTO 
 
Lo strumento FFF offre il vantaggio di ottenere una separazione di soluzioni di proteine, polimeri e 
sospensioni di particelle colloidali in ambiente acquoso nel range di dimensioni compreso da alcuni 
nm fino a 1 μm. 
Il meccanismo di separazione si basa sulle forze idrodinamiche che si generano in un canale di 
separazione. 
Le particelle di più piccole dimensioni vengono trasportate più velocemente lungo il canale rispetto 
a quelle di dimensioni maggiori e perciò sono eluite più velocemente. Il campione viene quindi 
separato all'interno di questo canale a flusso, che svolge le funzioni di una colonna senza fase 
stazionaria o solida. 
La Flow‐FFF usa come forza di separazione un flusso di liquido perpendicolare al flusso del canale 
ed è la variante più utilizzata nella famiglia delle tecniche FFF: si ottiene una separazione ad alte 
risoluzione in un flusso molto sottile. 
La diffusione, associata ai movimenti Browniani, a sua volta, crea un movimento opposto. Le 
particelle più piccole, dotate di velocità di diffusione più elevate, tendono a raggiungere una 
posizione di equilibrio più in alto nel canale, dove il flusso longitudinale è più elevato. Quindi il 
gradiente di velocità che si instaura nel canale separa le particelle di differenti dimensioni. Le 
particelle più piccole sono trasportate molto più velocemente lungo il canale rispetto a quelle più 
grandi, con il risultato che le particelle di dimensioni più piccole eluiscono prima di quelle più 
grandi, comportamento opposto a quello che si verifica nella cromatografia ad esclusione 
dimensionale o nella gel permeazione, in cui le particelle più grandi eluiscono per prime.  
Nello specifico, il principio di separazione si basa sul fatto che, le particelle/polimeri che eluiscono 
in un canale lungo e sottile in seguito ad un determinato flusso (Tip flow), nel momento in cui sono 
sottoposte ad un flusso perpendicolare al loro percorso (Cross flow), verranno trasportate con 
velocità diverse lungo il canale in base alle loro dimensioni (Fig 1). Il cross flow infatti spinge le 
particelle contro la membrana di cellulosa (cut off 10000 Da) che delimita il canale; le particelle 
con dimensioni inferiori al cut off attraversano la membrana e vengono eliminate.  
A inizio corsa viene attivato anche il focus flow che arriva dal centro del canale e risale 
contrastando il Tip flow allineando in questo modo tutte le particelle a inizio canale. 
Finito il focusing step (da pochi secondi ad alcuni minuti), il sistema, attraverso il transition step, 
passa all’elution step: il Focus flow lentamente viene azzerato. Le particelle soggette a tali flussi 
usciranno dal canale in base alle loro dimensioni, generalmente prima le particelle più piccole e poi 
via via le più grandi.  
All’uscita del canale l’eluato entra in serie in 2/3 detector (UV, eventualmente il fluorimetro, e Zeta 
sizer).   
 

2. CONFIGURAZIONE DEL SISTEMA 
 

Lo strumento è costituito da: 
 Degasatore 
 Focus pump 
 Tip pump 
 Kloehn pump (cross flow) 
 Canale costituito da: 

o bottom clamp 
o channel bottom contenente il frit metallico (e non ceramico)  
o la membrana con cut off 10000 Da 
o spacer da 350 μm (sono disponibili anche da 190, 250 e 500 μm in base alle 

dimensioni delle particelle da eluire): lo spacer da 350 μm è il miglior compromesso 
per tutte le condizioni sperimentali testate nel collaudo e richieste dagli utilizzatori 



o top block in plexiglass 
o top clamp che porta le viti per assemblare il tutto. 

 Rheodyne con Loop da 20 µl per l’iniezione del campione 
 Tubo in pic marrone di connessione al detector (backpressure) del diametro di 0.005 pollici 

(invece che l’originario nero di 0.004 pollici) disponibile in 2 lunghezze a seconda del flusso 
che si vuole avere al detector (0,5 – consigliabile per lo Zetasizer - o 1.0 ml/min) 

 Tubi in pic di varie dimensioni (comunque superiori a 0.01 pollici) di connessione con il 
detector UV 

 Detector UV, dotato di lampada al deuterio (190-700 nm di range), con sensitivity 
regolabile: 0.001 (+ alta) per le nanoparticelle e soluzioni diluite di polimeri o proteine 
(<10mg/ml), 0.01 (+ bassa) per le soluzioni concentrate (>10mg/ml) di polimeri e proteine 

 Cella per fluorimetro (trasportabile se necessario) con tubi di acciaio 
 Tubo in teflon di connessione alla cella di flusso dello Zetasizer, del diametro di 0.01 pollici 
 Cella a flusso per Zetasizer 
 Detector Zetasizer nano 
 Tubo di scarico in tefon del diametro di 0.03 pollici 
 PC (in rete) di controllo ed acquisizione del segnale dell’FFF e di tutti i detector; sul PC è 

installato il software AF2000, che controlla le pompe e acquisisce il segnale UV e 
fluorimetrico e il software Zetasizer 7.11 che controlla e acquisisce il segnale dallo Zetasizer 
nano 

 
NB: Alcune variazioni possono essere apportate alla configurazione del sistema, su richiesta di 
intervento di Postnova, e a totale carico economico dell’utilizzatore richiedente sia per 
l’installazione, che per le parti di ricambio: 

es. frit ceramico (+ delicato), attualmente non disponibile, da sostituire a quello metallico, 
per lavorare in condizioni metal-free 
es. altri detector, in particolare detector multi angle light scattering e viscosimetrici, 
attualmente presenti in open access di ateneo, e che consentono di risalire al peso 
molecolare assoluto 

 
3. PRECAUZIONI E AVVERTENZE D’USO 
 
 La configurazione del sistema non può essere cambiata senza consultare Postnova (Gerhard 

Heinzmann gerhard.heinzmann@postnova.com), nè dal punto di vista dell’assemblaggio dei 
componenti, nè dal punto di vista della configurazione software; 

 tutti gli eluenti (anche se costituiti da acqua milliQ) vanno filtrati sotto vuoto con unità 
filtrante (appositamente acquisita) e filtri da 100 nm, allo scopo di evitare l’intasamento dei 
filtri di sicurezza in teflon presenti sulla focus e sulla tip pump. 
Per tale operazione è a disposizione un sistema di filtraggio sottovuoto costituito da una 
beuta (2 l) con tappo codato e supporto per il filtro abbinato ad un recipiente ad imbuto da 
carico del volume di 500 ml; il tutto assemblato tramite pinza metallica; 

 tutti i campioni in sospensione, ad esclusione degli standard di lattice, vanno filtrati su filtro 
(1.2-1.5 µm) prima dell’iniezione, allo scopo di allontanare le microparticelle e i loro 
aggregati che potrebbero intasare il tubo di backpressure; l’indagine della presenza di 
microparticelle all’interno dell’analita è da evitare, dal momento che esse sono escluse dal 
range dimensionale del sistema; 

 il flusso al detector da utilizzarsi è di 0.5 ml/min, dal momento che esso deve essere 
compatibile con l’acquisizione da parte dello Zetasizer (ogni 3 secondi); qualora lo Zetasizer 
venga escluso dai detector, si può operare anche ad 1 ml/min, previa sostituzione del tubo di 



backpressure con uno più corto (già a disposizione): è da sottolineare però che l’analisi a 1 
ml/min non porta vantaggi in termini di separazione rispetto a 0.5 ml/min; 

 qualora la pressione dei filtri in teflon sulla tip e focus pump superasse il livello di allarme 
segnalato dal software, si rende necessaria la loro sostituzione da parte di personale 
adeguatamente formato; 

 qualora la separazione degli standard di lattice (90, 170, 300, 500 nm) non fosse efficiente, 
si rende necessaria la sostituzione della membrana da parte di personale adeguatamente 
formato; 

 per tutte le informazioni relative alla chimica e alla tecnologia del sistema bisogna contattare 
via mail la Postnova (Dr. Evelyn Moldenhauer Moldenhauer@postnova.com e Dr. Gerhard 
Heinzmann gerhard.heinzmann@postnova.com), mettendo in copia Alfatest 
(roberto.santoliquido@alfatest.it, andrea.denti@alfatest.it); per tutti gli ordini di 
consumabili bisogna far riferimento ad Alfatest (roberto.santoliquido@alfatest.it, 
andrea.denti@alfatest.it). 

 
 
 
 
 

4. METODICHE OPERATIVE 
 
Premessa: IMPOSSIBILITÀ DI SEPARARE PARTICELLE > 1000 NM, PERCHÈ ESCONO 
PRIMA PER EFFETTO STERICO 

 
 Per i campioni in soluzione acquosa (proteine e polimeri) l’eluente da utilizzarsi è NaCl 

0.9%; 
 per i campioni in sospensione, l’eluente più comunemente utilizzabile è la miscela 

Novachem 0.05% + NaCl 0.05%; tale miscela è idonea per la rivelazione con detector 
Zetasizer (qualora il detector Zetasizer sia escluso, è possibile utilizzare anche il semplice 
Novachem 0.2%); tale eluente è ottimizzato per gli standard in lattice, testati nel collaudo: 
piccole variazioni della composizione dell’eluente possono essere apportate a seconda della 
natura chimica del campione in sospensione, previo accordo con gli esperti di Postnova, 
contattabili via mail (Dr. Evelyn Moldenhauer Moldenhauer@postnova.com e Dr. Gerhard 
Heinzmann gerhard.heinzmann@postnova.com); 

 Per l’analisi di campioni contenenti sistemi liposomiali, l’eluente più comunemente usato è 
il PBS. L’eluente a base di Novachem non può essere utilizzato, in quanto contenente 
tensioattivi. 

 Premesso che piccole variazioni della composizione dell’eluente possono essere necessarie a 
seconda della natura chimica dell’analita, i programmi per l’eluizione sono sostanzialmente 
4: 

 metodo 1: per soluzioni acquose di proteine (>10000 Da) 
 metodo 2: per soluzioni acquose di polimeri (>50000 Da) 
 metodo 3: per sospensioni acquose di nanoparticelle o liposomi <100 nm 
 metodo 4: per sospensioni acquose di nanoparticelle o lipsosomi >100 nm: il 

limite di esclusione superiore è di 1 micron, ma al di sopra dei 500 nm non si 
ottiene una separazione netta dei picchi alla linea di base; al di sopra di 1 micron 
è sconsigliabile utilizzare lo strumento, sia per problemi di intasamento del tubo 
di backpressure, sia perché essi verrebbero eluiti in ordine inverso a causa 
dell’effetto sterico 

 metodo 5: per sospensioni acquose di nanoparticelle o liposomi < 200 nm 



 sul detector UV possono essere regolate la lunghezza d’onda e la sensitivity; per quanto 
attiene la lunghezza d’onda essa è regolabile a seconda della natura del polimero o della 
proteina in soluzione, mentre, per quanto riguarda i campioni in sospensione, il detector 
rileva la torbidità, per cui la lunghezza d’onda di default (280 nm) può essere idonea per 
tutti i campioni; per quanto riguarda la sensitivity, essa può essere impostata a 0.001 per i 
campioni in soluzione diluiti (<10mg/ml) e a 0.01 per i campioni in soluzione concentrati 
(>10 mg/ml);  

 il detector Zetasizer deve essere impostato per acquisire con cella di flusso (secondo appositi 
parametri) con un tempo di 3 secondi per ogni funzione di autocorrelazione: l’analisi di 
campioni in soluzione (polimeri e proteine) richiede concentrazioni relativamente alte (>10 
mg/ml), mentre per le sospensioni, la concentrazione necessaria varia a seconda della 
dimensione. Pertanto, in questo caso occorre effettuare un’analisi DLS preliminare (vedi 
sotto) in batch in modo da definire la concentrazione idonea.  

 l’eluizione di campioni monodispersi a dimensione nota attraverso il canale, anche se 
rivelata solo con detector UV, può servire da scala dimensionale per campioni incogniti 
della stessa natura chimica: pertanto è possibile calibrare lo strumento con degli standard 
noti; iniettare quindi un campione incognito, della stessa natura chimica, e far estrapolare 
dal software la sua dimensione teorica, anche solo con il segnale UV. 
Il dato fornito dallo strumento è qualitativo e non quantitativo, in quanto l’intensità del 
segnale acquisito dai detector varia in base alle dimensioni; allo scopo di fare una analisi 
quantitativa su un campione incognito, bisogna disporre di standard monodispersi a 
dimensione nota (della stessa natura chimica dell’analita) da iniettare nel sistema senza 
cross-flow (quindi senza separazione), in modo tale da consentire al software di effettuare 
una calibrazione 
 
 

5. UTILIZZO DEI SOFTWARE  
 
5.1 CARICAMENTO DEI METODI 
 
Software AF2000 
-Aprire il software AF2000 dal desktop in modalità START PROGRAM (NO DEMO) 
-Selezionare il metodo: File →Open →Run 
-Selezionare la cartella Postnova information → fff → run → training→ scegliere il metodo 
adeguato al tipo di campione 
-Compare una videata con Run e FFF Method 
-In Run inserire la directory selezionando/creando la propria cartella di salvataggio dei dati, inserire 
il nome del proprio campione nella finestra “Name”, inserire a destra la sample conc., ripetere il 
nome nella finestra “sample” e inserire propri commenti sul campione nella finestra a destra 
“sample description”. 
-Schiacciare “Save” presente nella parte sinistra. 
 
 
Software Zetasizer 
Nel caso di abbinamento con il detector Zetasizer, procedere con l’impostazione del Zetasizer 
software della Malvern: 
-Aprire il software dal desktop   
-Inserire “flow” nella casella presente sulla barra dei comandi scegliendo dal menù a tendina. 
-Creare un novo file di misura: File →New→Measurement file salvandolo in una apposita cartella 
-Selezionare un metodo: File →Open→SOP 



-Selezionare la cartella Postnova information → dls → sop → training→ scegliere il metodo 
adeguato al tipo di campione 
- Si apre una videata: nella parte destra si seleziona “sample” e si inserisce il nome del proprio 
campione a destra; si seleziona a sinistra “material” e si inserisce/sceglie nel menù a tendina il 
materiale del proprio campione (nel caso di un nuovo inserimento andranno inseriti anche il RI e il 
coefficiente di assorbimento: è presente nel cassetto DLS/ZETA un plico cartaceo su cui sono 
raccolti tali dati per alcuni materiali). 
-File →Save as→selezionare/creare la propria cartella e salvare. 
-Measure →Start SOP 
-Multiview 
 
 

5.2 AVVIO ANALISI ED INIEZIONE DEL CAMPIONE 
 

Prima di procedere con l’iniezione del campione occorre effettuare due operazioni PRELIMINARI 
al DLS: 
 
1) Stabilire, con una lettura in batch (cella statica), se la concentrazione del campione è idonea per 

il segnale DLS, in caso contrario occorrerà effettuare una diluizione del campione con eluente. 
Questo passaggio, tiene conto del fatto che il campione nel canale viene diluito 
approssimativamente di un fattore 1:100. Pertanto, si procede diluendo una piccola parte di 
campione 1:100 con eluente, si riempie quindi una cella di tipo statico e si effettua una lettura 
DLS preliminare in batch. La concentrazione del campione iniziale può essere considerata 
idonea, se la sua diluizione 1:100 presenta un numero di colpi compreso nel range 1000< 
kcps<10000. 
 

2) Verificare che la cella di quarzo (a flusso) all’interno dello Zetasizer sia pulita. A tale scopo, 
misurare il numero di colpi utilizzando il contapassi collocato sotto la voce TOOLS nel software 
dello Zetasizer, cliccare “Count Rate Meter” e Impostare i parametri seguenti: 

a. current position (mm) 4.20, clicca SET 
b. attenuator 11, clicca SET 
c. scegliere il tipo di cella dal menu a tendina: ZEN0023 QUARTZ CELL. 

È preferibile che i colpi non superino la soglia di 100 kcps. In caso contrario, procedere con la 
pulizia delle pareti esterne della cella, sfregando le pareti con carta assorbente pulita o, 
eventualmente imbevuta con metanolo e in seguito con acqua deionizzata.  
 
 

 
Infine si ricorda che, prima di procedere con l’iniezione, occorre accertarsi di avere filtrato sia 
l’eluente  (con filtro da 0.1 µm) che il campione (con filtro da 1.2-1.5 µm) onde evitare 
l’intasamento del sistema (vedi paragrafo 3). 
 
Nel caso in cui, dopo un lungo periodo di inutilizzo, vi sia aria nel sistema è necessario mettere il 
sistema a: 
cross flow: 1.5 ml/min 
focus flow: 1.0 ml/min 
tip flow: 1.0 ml/min 
 
e lasciare tali condizioni finché la pressione al detector non raggiunge valori compresi tra 8 e 9 bar. 
 



 quando il sistema è condizionato, selezionare “Preset Flow” sul software AF2000: il sistema 
in automatico avvierà i flussi come impostati da programma; 

 caricare il campione filtrato nella siringa HPLC (almeno 50 µl); 
 click su “Run” nella videata FFF Method; 
 dopo avere verificato che il Rheodyne sia in posizione di carico (in alto), procedere con 

l’iniezione del campione ruotando il rheodyne verso il basso; 
 contemporaneamente fare click su “Start” nel software Zetasizer (se si interrompe l’analisi 

dls prima della fine dell’analisi programmata, i dati registrati in grafico verranno persi). 
 

Il software FFF fornisce un frattogramma del segnale UV rispetto al tempo; il DLS fornisce un 
frattogramma del contapassi rispetto al tempo e un diagramma a scalini della dimensione rilevata in 
corrispondenza di ogni picco del frattogramma. 
Terminata l’analisi, i dati sono automaticamente salvati: per quanto riguarda il DLS nel 
measurement file già predisposto, per quanto riguarda l’FFF nella stessa cartella dove è stato 
salvato il run, come file dat. 
 
 
 
 
 
 
 
 
 
 
 

5.3 RIELABORAZIONE DEI DATI (OPERAZIONI BASILARI) 
 
Software AF2000 
-aprire il file dat salvato: File →Open →Data 
-non è possibile col software AF2000 integrare l’area sottesa ai picchi: per ricavare informazioni 
sulla concentrazione del campione iniettato, bisogna effettuare una calibrazione dalla maschera 
evaluation, conoscendo l’assorbività molare dell’analita; se essa è ignota bisogna disporre di 
standard monodispersi a dimensione nota (della stessa natura chimica dell’analita) da iniettare nel 
sistema senza cross-flow (quindi senza separazione), in modo tale da consentire al software di 
effettuare una calibrazione 
-si possono sovrapporre i frattogrammi con quelli di standard noti acquisiti con lo stesso metodo: in 
tal caso aprire i diversi file dat e poi selezionare in alto Data→Show Overlay Window 
 
Software Zetasizer 
-aprire il Measurement file salvato 
-Edit→Results: si apre una nuova maschera 
-in alto a destra, cancellare i picchi evidenziati in automatico dal software con il tasto remove 
-sul grafico evidenziare col mouse l’inizio e la fine del picco di interesse nel frattogramma 
contapassi/tempo: con tasto destro del mouse sul picco evidenziato selezionare DLS analysis, in tal 
modo a destra comparirà la dimensione media corrispondente al picco indicato 
 



6. ESEMPI DI SEPARAZIONE DI STANDARD ANALITICI TRAMITE FFF 
EFFETTUATE DURANTE IL TRAINING DI BASE 

 
 BSA (69000Da) e suo dimero 

Metodo 1 
Eluente NaCl 0.9% 
Concentrazione 5 mg/ml 
 
Metodo 1 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Il frattogramma DLS non è disponibile in quanto per avere un buon segnale al DLS si sarebbe 
dovuto iniettare un campione 25 mg/ml di BSA: tale campione con la sensitivity di 0.001 sarebbe 
andato fuori scala con il detector UV, si sarebbe pertanto dovuta usare una sensitivity di 0.01 
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 Polistirene sulfonato (64000 Da) 
Metodo 2 
Eluente NaCl 0.9% 
Concentrazione 10 mg/ml 
 
Metodo 2 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Il frattogramma DLS non è disponibile in quanto per avere un buon segnale al DLS si sarebbe 
dovuto iniettare un campione 50 mg/ml di polistirene sulfonato: tale campione con la sensitivity di 
0.001 sarebbe andato fuori scala con il detector UV, si sarebbe pertanto dovuta usare una sensitivity 
di 0.01 
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Latex mix nanoparticelle 22-58-100 nm 
Metodo 3 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione 25-2.5-0.5 mg/ml 
 
Metodo 3 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Frattogramma DLS 

 
 
non considerare il pre-picco e il post-picco, che sono rinvenuti con il Novachem 
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Record 1: L22 L58 L100 Latex 1 (Intensity) Record 1: L22 L58 L100 Latex 1 (Z-Average)



Latex mix nanoparticelle 63-150-288 nm 
Metodo 4 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione 25-2.5-1.5 mg/ml 
 
Metodo 4 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Frattogramma DLS 

 
 
non considerare il pre-picco, che è rinvenuto con il Novachem 
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Record 49: L63 L150 L288 Latex 1 (Intensity) Record 49: L63 L150 L288 Latex 1 (Z-Average)



Latex mix nanoparticelle 200-600 nm 
Metodo 4 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione 32-160 mg/ml 
 
Metodo 4 (vedi sopra) 
 
Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Frattogramma DLS 

 
 
non considerare il pre-picco, che è rinvenuto con il Novachem 
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Record 1: L200 L600 Latex 1 (Intensity) Record 1: L200 L600 Latex 1 (Z-Average)



Latex mix nanoparticelle 90-170-300-500 nm (standard Coulter) 
Metodo 4 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione incognita 
 
Metodo 4 (vedi sopra) 
 
Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Frattogramma DLS 

 
 
non considerare il pre-picco, che è rinvenuto con il Novachem 
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Record 1: L90 L170 L300 L500 Latex 1 (Intensity) Record 1: L90 L170 L300 L500 Latex 1 (Z-Average)



Latex mix nanoparticelle 200-600-1000 nm 
Metodo 4 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione 32-160 mg/ml-incognita 
 
Metodo 4 (vedi sopra) 
 
Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Frattogramma DLS 

 
 
non considerare il pre-picco, che è rinvenuto con il Novachem 
IMPOSSIBILITA’ DI RISOLVERE ALLA LINEA DI BASE PICCHI SOPRA 500 NM  
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Record 1: L200 L600 L1000 Latex 1 (Intensity) Record 1: L200 L600 L1000 Latex 1 (Z-Average)



Latex mix nanoparticelle 170-500-5000 nm (standard Coulter) 
Metodo 4 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione incognita 
 
Metodo 4 (vedi sopra) 
 
Frattogramma FFF – sensitivity 0.001 per UV 

 
 
Frattogramma DLS 

 
 
fare attenzione al pre-picco molto grande, dovuto probabilmente alle particelle di 5000 nm 
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Record 1: L170 L500 L1000 Latex 1 (Intensity) Record 1: L170 L500 L1000 Latex 1 (Z-Average)



 
Latex mix nanoparticelle Novachem 22-58-100 nm  
Metodo 5 
Eluente Novachem 0.05% + NaCl 0.05% 
Concentrazione: 25-2.5-0.5 mg/ml 

    
 

 
Metodo 5 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
Frattogramma FFF – sensitivity 0.001 per UV 
 
 

 
 
 
Frattogramma DLS 
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Record 7: STD- 22_58-100- 21-11-14 tal quale 1 (Intensity)
Record 7: STD- 22_58-100- 21-11-14 tal quale 1 (Z-Average)



LIPOSOMI 220 nm 
Metodo 5 (vedi sopra) 
Eluente PBS 
Concentrazione 10 mg/ml 
 
Frattogramma FFF – sensitivity 0.001 per UV 
 

 
 
 
 
Frattogramma DLS 

 


